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	The Computer—An Overview

Exercise

A.	 1.	a.	 2. b.	 3. a.
B.	 1.	impact	 2. webcam	 3. joystick	 4. microprocessors
C.	 1.	F	 2. F	 3. F
D.	 1.	A computer is an electronic machine that accepts data given by user, process the data as per 

given instructions and produces results.
	 2.	A touchscreen is a screen that is sensitive to touch and helps us to interact with computers 

by touching the areas on the screen.
E.	 1.	
	 2.	Limitations of a Computer are:
	 	 •  Lack of decision-making ability
	 	 •  Lack of intelligence
	 	 •  Lack of feelings or emotions

Brain Teaser
A.	 1.	Joystick	 2. Touchscreen
B.	 1.	Plotter	 2. Joystick	 3. Microphone

	Computer Memory

Exercise

A.	 1.	a.	 2. c.	 3. b.	 4. a.
B.	 1.	Random Access Memory	 2. Read only memory
	 3.	GB	 4. USB

1.

2.
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C.	 1. 	Hard disk is a secondary storage device that is used to store data permanently.
	 2.	A memory card is a multimedia memory card that is used in mobiles and digital cameras to 

store data.
	 3.	Type of CD’s are: CD ROM, CD-RW, CD-R
D.	 1.	There are two types of RAM
	 	 •  Static RAM
	 	 •  Dynamic RAM
	 2.	Type of Memory
		�  Primary Memory—It is the main memory of the computer that can be accessed by the CPU 

directly. It is fixed on the motherboard. There are two types of Primary memory. RAM and 
ROM

		  Secondary memory—It is the permanent memory that is not directly accessed by the CPU. 
It allows users to store data that may be easily retrieved. The secondary memory devices are 
Hard disk, CD’s, DVD’s and Pen drives.

Brain Teaser
A.	 1.	Hard disk	 2. Memory card	 3. Blu-ray disc	 4. Pen drive

B.	 3   Pen drive		  1   CD

	 2   DVD		  4   Hard disk

	More on Windows 7

Exercise

A.	 1.	 a.	 2. b.	 3. a.	 4. c.
B.	 1.	downloads	 2. folder	 3. subfolder	 4. Windows Explorer
C.	 1.	T	 2. T	 3. T	 4. T
D.	 1.	b.	 2. d.	 3. a.	 4.	 5. c.
E.	 1. 	Common folders provided by windows 7 are:
	 	 •  Documents	 •  Pictures	 •  Music
	 	 •  Videos	 • Downloads
	 2.	Organized files and folders help us to find the right files to use when we run a program.
	 3.	When we copy a file then the file remains at its original location and also appear in the new 

location. When we move a file, it is removed from its original location to a new location.
	 4.	Renaming a file means changing the name of the file or folder as your own choice and change 

the default name of the file or folder.
F.	 1.	Difference between a folder and file. A folder is collection of various files and sub folders 

whereas a file is a collection of related information.

3.
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	 2.	Steps to delete a file or folder.
		  Step 1:	 Open the file or folder you want to delete.
		  Step 2:	 Click on File or folder
		  Step 3:	 Click on Organize
		  Step 4:	 Click on Delete
		  Step 5:	 Click on Yes
		  Step 6:	 The file or folder will be deleted.

Brain Teaser
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Periodic Assessment 1
(Based on chapters 1 to 3)

A.	 Forward Address bar Search

Status bar

Back

Toolbar

Navigation
pane

File list 
pane
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B.	 1.	c.	 2. d.	 3. a.	 4. b.
C.	 Pendrive

	Graphics in MS Word 2010

Exercise

A.	 1.	b.	 2. b.	 3. c.	 4. c.
B.	 1.	Shapes	 2. Insert	 3. Add text	 4. ClipArt
	 5. WordArt	 6. 3D
C.	 1. 	c.	 2. d.	 3. a.	 4. e.	 5. b.
D.	 1.	T	 2. F	 3. F	 4. T	 5. F
	 6. F
E.	 1.	Click on Insert Tab  Shapes  Choose Shape  Drag in the text area
	 2.	By clicking on the Fill command in the shape style group in Format tab.
	 3.	Symbols are punctuation or special characters generally not found on keyboard.
F.	 1.	Click on Shapes present in Format tab  Click on shape outline in shape style group  

Choose colour from the drop-down box of colours.
		  To change the thickness  Click on Format tab  Shape effect command in shape style 

group  Bevel option  Select desired bevel effect.
	 2.	WordArt allows us to create text effects that cannot be inserted through text formatting.
	 	 ClipArt helps us to insert pre-designed pictures to make our document look professional.
	 3.	Place the cursor where you want to insert pictures  Click on Insert tab  Insert picture from 

illustrations group  Choose the desired picture  Click on Insert button and the picture 
will be inserted.

Brain Teaser

	 1   Click on the Format tab.

	 3   Hover the mouse over 3-D Rotation option from the drop-down menu.

	 4   Select the desired rotation effect from the sub-menu.

	 2   Click on the Shape Effects from the Shape Styles group.

4.
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	Tables in MS Word

Exercise

A.	 1.	b.	 2. b.	 3. c.	 4. a.
B.	 1.	F	 2. T	 3. T	 4. F
C.	 1.	Resizing	 2. Merging	 3. Layout	 4. Design
D.	 1.	Cell is the intersection of rows and columns.
	 2.	Table style is a collection of in-built table styles.
E.	 1.	To add a row, follow these steps:
		  Step 1:	 Select the row where you want to add another row.
		  Step 2:	  Click on the layout tab.
		  Step 3:	 Click on Insert Above or Insert Below command. A row will be added.
	 2.	To add a table using Insert Table command with more number of rows and columns, follow 

these steps:
	 	 Step 1:	 Click on the Insert tab.
		  Step 2:	 Click on the Table command in the Tables group.
	 	 Step 3:	 Click on the Insert Table option. The Insert Table dialog box will appear.
		  Step 4:	 Enter the required number of columns and rows you want to insert.
		  Step 5:	 Click on OK button. The table will be inserted.
	 3.	Merging refers to combine two or more cells in the same row or same column into a single 

cell whereas Splitting refers to dividing one cell into two or more cells.

Brain Teaser
A.	 1. Insert above	 2. Insert below	 3. Delete	 4. Merge cells
	 5.	Split cells

5.
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Periodic Assessment 2
(Based on chapters 4 & 5)

A.	 1.	Shape outline	 2. Insert tab	 3. Design	 4. Cell
B.	 1.	Insert	 2. ClipArt	 3. rows	 4. Symbols
C.	 1.	T	 2. F	 3. T	 4. F
D.	 1.	d.	 2. a.	 3. b.	 4. c.
E.	 Table

Test Sheet 1
(Based on chapters 1 to 5)

Section A
A.	 1.	b.	 2. a.	 3. a.	 4. c.	 5. b.
	 6. b.
B.	 1.	Pixels	 2. Platters	 3. Sub folder	 4. Format
C.	 1.	T	 2. F	 3. T
D.	 1.	d.	 2. c.	 3. a.	 4. b.

Section B
A.	 1.	It allows us to insert various ready-made shapes in the word document.
	 2.	It is the main memory of the computer. CPU can directly access this memory. It is fixed on 

the Motherboard.
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	 3.	Renaming a file means to change the default name of the file and give it a new name as per 
your choice

	 4.	Flatbed, Handheld, sheetfed.
B.	 1.	Limitation of computers
	 	 •  Lack of decision-making ability
	 	 •  Lack of intelligence
	 	 •  Lack of feelings or emotions
	 2.	Different types of printers.
		  i.	� Dot-matrix printer: It works like a typewriter. The printer head strikes the paper and 

ink ribbon to print a character. It is an impact printer.
		  ii.	� Inkjet printer: These are non-impact printers. It prints line by line by spraying ink on 

a sheet of paper. These printers are much faster than dot matrix printer. These are 
expensive and consume more ink.

		  iii.	� Laser printer: These are also non-impact printers. IT uses a laser beam to print on the 
paper.

	 	 These are much faster than the inkjet printer and print quality of these printer is superior

	More on MS PowerPoint 2010

Exercise

A.	 1.	c.	 2. a.	 3. b.	 4. c.
B.	 1.	Slides	 2. Slide layout	 3. Reading	 4. Saved images
	 5.	Slide show
C.	 1.	F	 2. F	 3. T	 4. T
D.	 1.	A slide layout is the arrangement of text, images, clipart and charts etc. on a particular slide.
	 2.	Normal view
	 3.	List, process and cycle
E.	 1.	Insert tab  Illustration group  Smart art command  Choose a graphic type form the left 

section of dialogue box  choose design and click OK.
	 2.	Normal view: This view is the default view of presentation. It shows current slide, outline 

and notes pane.
		  Outline view: This view displays the slide in outline format.
		  Slide Sorter view: This view shows the miniatures of the slides and allows to change the 

order of the slides.
		  Reader View: This view shows the presentation not in full screen but with simple controls 

to review the presentation.

6.
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Brain Teaser
	 1.	Slide show	 	 2. Word Art/ Text box
	 3. Notes pane		  4. Reading view

	 Introduction to MS Excel 2010

Exercise

A.	 1.	c.	 2. c.	 3. b.	 4. a.
B.	 1.	Name box	 2. Title 	 3. Quick Access	 4. Formula
	 5.	Worksheet
C.	 1.	F	 2. T	 3. F	 4. F	 5. F
D.	 1.	Cell range- It is a collection of two or more cells.
	 2.	Ribbon is a bar that has tabs with groups of related commands displayed in it.
	 3.	This is the currently selected cell that appeared highlights with a dark border.
E.	 1.	It is used to edit and enter formulas. It is also used for entering and editing the cell contents.
	 2.	A workbook is a collection of different worksheets. By default, a worksheet contains 3 sheets. 

A worksheet is a single page in excel.
	 3.	The two components of MS Excel Window are:
		  Title bar: It is located on top of the window and shows name of the current worksheet.
		  Ribbon: It has tabs with group of related commands displayed.

Brain Teaser
	 1.	D3	 2. D5	 3. E4	 4. C4	 5. A4 
	 6.	G4

Periodic Assessment 3
(Based on chapters 6 & 7)

A.	 1.	Slide Layout	 2. Slide Sorter	 3. Notes Page	 4. Reading View
	 5.	WordArt

7.
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B.	 Quick Access Toolbar Title bar

Formula 
bar

Name Box

Status bar
Mouse pointer

Active cell

Sheet tab

C.	 MS Excel 2010

	More on Internet

Exercise

A.	 1.	a.	 2. c.	 3. b.	 4. a.
B.	 1.	Information	 2. Search engines	 3. downloading	 4. uploading
C.	 1.	c.	 2. a.	 3. d.	 4. b.
D.	 1.	F	 2. T	 3. T	 4. F	 5. F
E.	 1.	Goggle chrome	 2. Internet Explorer	 3. Mozilla Firefox
F.	 1.	�Internet is a network in which millions of computers are connected one another to share 

information.
	 2.	Facebook, Twitter and Instagram
	 3.	Getting data from the host computer to the client computer is called as downloading.
G.	 1.	Uses of internet
	 	 •  We can buy and sell goods online.
	 	 •  We can search information on any topic.
	 	 •  We can send and receive messages from all over the world.
	 2.	It is a company that provides internet access to people on payment of a monthly fees like 

Airtel, Vodafone, etc.
	 3.	Telephone lines and cables, Modem, Computer System, web browser and ISP.

Brain Teaser

8.
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A.	 1.	URL	 2. Surfing	 3. Telephone and Cable lines
	 4.	Internet/Web browser
B.	 1.	Whatsapp 	 2. Instagram 	 3. Twitter 	 4. Facebook

THE CT CORNER!
(DATA PROCESSING)

A.	 1.	HELLO	 2. LOGO	 3. DVD	 4. MOUSE	 5. DATA
B.	

Name of the Item Number of the Item
1. Shuttle Cock 7
2. Football 5
3. Chair 4
4. Table 3
5. Hockey Stick 5

Name of the Item Number of the Item
1. Shuttle Cock 7
5. Hockey Stick 5
2. Football 5
3. Chair 4
4. Table 3

	Programming in Scratch

Exercise

A.	 1.	c.	 2. b.	 3. b.	 4. b.
B.	 1.	looks	 2. forever	 3. relational	 4. string
C.	 1.	T	 2. F	 3. T	 4. T	 5. T
D.	 1. 	Variable blocks are used to hold values and strings.
	 2.	Pen up and Pen down
E.	 1.	Arithmetic, Logical and Relational
	 2.	a. Stamp: It duplicates sprites image on to the stage.
		  b. Hide: Makes sprite disappear from the stage

9.
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	 3.	Write the difference between the following:
		  a.	� Forever block is a control block that runs the script continuously until stopped. If then 

else checks the given condition. If the condition is true the then code inside the first 
space is activated0 else the code inside0 the second space is activated.

		  b.	� Looks block controls sprite’s appearance whereas the Pen block allows sprite to draw 
shapes and plot colored pixels on the screen.

Brain Teaser
	 1.	Pen block	 2. Control block	 3. Operator block	 4. Looks block
	 5.	Variable block	 6. Operator block	 7. Pen block

Periodic Assessment 4
(Based on chapters 8 & 9)

A.	 1.	Show	 2. Say_for_seconds	 3. stamp	 4. Not
	 5.	If 	 6. Forever
B.	 1.	d.	 2. a.	 3. b.	 4. c.
C.	 1.	INFORMATION	 2. DOWNLOADING	 3. ONLINE CHAT	 4. UPLOADING
D.	 1.	Arithmetic operator	 2. Relational Operator
	 3.	Logical Operator

Test Sheet 2
(Based on chapters 6 to 9)

Section A
A.	 1.	c.	 2. a.	 3. c.	 4. a.	 5. a.
B.	 1.	Slides	 2. Slide Show	 3. Worksheet	 4. String
C.	 1.	T	 2. F	 3. F	 4. T	 5. F
	 6.	T
D.	 1.	c.	 2. d.	 3. a.	 4. e.	 5. b.

Section B
A.	 1.	It is cell which have dark black border around it.
	 2.	It is an application software that helps us to access internet.
	 3.	Title bar, Ribbon, Name box, Quick Access toolbar, Formula bar, Cell, Rows and columns, 

sheet tabs, Scroll bars, Active cell,
	 4.	Slide layout refers to the way of arranging objects on a slide.
	 5.	Internet can be used to buy and sell thing online and send and receive messages.
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B.	 1.	�Normal view: This view is the default view of presentation. It shows current slide, outline 
and notes pane.

		  Outline view: This view displays the slide in outline format.
		  Slide Sorter view: This view shows the miniatures of the slides and allows to change the 

order of the slides.
		  Reader View: This view shows the presentation not in full screen but with simple controls 

to review the presentation.
	 2.	Stamp block duplicates the sprite’s image on the stage.
	 3.	Computer system, Telephone and cable lines, Web browser, ISP and Modem.




